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Doc-To-Help Quick Tour 

This mini self-paced tutorial will show you how easy it is to create a project in Doc-To-Help, as well as build your 

output, apply styles, create links, and more. You will build a project about Pittsburgh using two existing documents. This 

Quick Tour uses Microsoft® Word as the document editor, but the same principles apply when you are using Doc-To-

Help's built-in Content Editor or an HTML editor.  

 

The Doc-To-Help in 5 Lunches Tutorial Series is another quick start resource you should check out. It has Word and 

Built-In Editor versions, plus accompanying videos. See Learn How Doc-To-Help Works in Five Lunch Breaks. 

 

As you are working through this Quick Tour, you may want to learn more about the features discussed — if so, please 

refer to the Dynamic Help window, or click the Help button  to open Doc-To-Help online Help. 

 

 Watch the video: Starting a New Project in Doc-To-Help (3:48) 

 

 

http://our.doctohelp.com/2012/05/14/learn-how-doc-to-help-works-in-five-lunch-breaks/
http://www.youtube.com/watch?v=wrb5W9_LXsI
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Let's get started … 
 

Creating a new project is quick and easy with the Getting Started Wizard.  

 

This wizard opens when you open Doc-To-Help. It can also be used to open an existing project, open a sample project (a 

great way to test drive a Word or HTML5 project), or convert an older existing project to a Doc-To-Help Project.  

 

 

 
 

Choose Start a New Project and click Next.  

 

 

Note: If you have closed the Wizard, click the Getting Started Wizard button in the upper right to reopen it. 
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Name your project Pittsburgh. Doc-To-Help will automatically name the project location folder with the same name. 

 

Note that Doc-To-Help saves your project in the default My Doc-To-Help Projects folder. This makes it easy to keep 

your projects organized.  

 

(You can change the default folder if you wish, just click the File tab > Doc-To-Help Options button. Choose the Files 

button.) 

 

 
 

Click Next.  
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The next screen will give you the opportunity to import settings from an existing project. Since we are going to work 

through a few settings later, we will skip this screen. 

 

 
 

Click Next.  
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Now, you can select the default language for your project. By default, it is U.S. English, but you can choose another 

from the drop-down. 

 

Doc-To-Help will choose the correct character set based on the language chosen. 

 

 
 

Click Next.  
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Doc-To-Help uses templates and style sheets to determine how content will look and behave in both your Source 

documents (when authoring in Word, Doc-To-Help's built-in Content editor, or an HTML editor) and your final Targets 

— the online Help and printed manual outputs.  

 

Now you can use the wizard to select the style sheet (.css) for your HTML5 or HTML Source documents and the 

template (.dot) file for your Microsoft® Word Source documents. 

 

Doc-To-Help will automatically choose your Target style sheet and template based on your selections.  

 Leave the default setting of Full set of styles. 

 Leave the default setting of Normal 8-1/2" x 11" Template (no left indent).  

 

 
 

Click Next.  
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Now, select your default Help target. You can generate any of these targets from your project at any time, but the default 

chosen here will be the one displayed when you open your project. Choose NetHelp (Doc-To-Help's browser-based 

uncompiled HTML format). This output can be used on the web, within a software application, or on a file server.  

 

 
 

Click Next.  
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Now you select the type of document you'd like your first document to be. Choose Import existing files — because we 

are going to use an existing document to start our project. 

 

Doc-To-Help will launch another Wizard after the project is created that makes it easy to import an existing document. 

 

 
 

Click Next.  
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That's it! Review the new project information and click Finish. 
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Our project is created, but since we chose the Import existing files option, the Document Import Wizard will open. 

 

 
 

Choose Local and click Next. 
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Choose Microsoft® Word and click Next. 
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Choose Keep my content in Word and click Next. 
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Now click the Add file(s) button to select the file. The file you need is named PittsburghQuickTour.doc.  

 

The Select Files for Import dialog box will automatically open to the My Doc-To-Help Projects folder. 

PittsburghQuickTour.doc can be found in \Samples\All About Pittsburgh Sample Word\Documents. 

 

 
 

Click the Open button in the Select files for import dialog box. PittsburghQuickTour.doc will display in the Wizard. 

Please note that Doc-To-Help will automatically copy this file into the appropriate folder; your project's Documents 

folder. 
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Click Import and the document will be imported. 
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Click Close.  The imported document displays in the Documents pane. The Documents pane is "Home base" in Doc-

To-Help. 
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As noted earlier, our document was automatically added to the appropriate folder in the Doc-To-Help Pittsburgh project 

folder. Word source documents are stored in the Documents folder of the project. 

 

 
 

From the Documents pane, double-click on PittsburghQuickTour.doc to open it. In Microsoft® Word, take a look at 

the Doc-To-Help ribbon (it will be a toolbar in pre-2007 versions of Word). With it, you can create links, add index 

entries, and more. Doc-To-Help uses this information to create the final Targets.  

 

 
 

Now it’s time to learn more about specific Doc-To-Help features. Although the lessons below are divided up to make 

them more manageable, it is recommended that you do them in order so that you can see the progression of your project. 
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Building and Examining a Target 
 

So far, we've done very little, but we've given Doc-To-Help enough to work with. If we build right now, we can take a 

look at what Doc-To-Help will do out-of-the-box — but first, let’s take a quick look at our Word document. If it is not 

already open, double-click on PittsburghQuickTour.doc to open it. 

 

It is structured like this: 

Heading 1 — All About Pittsburgh 

Heading 1 — Pittsburgh Sports 

Heading 2 — Football 

Heading 2 — Baseball 

Heading 2 — Hockey 

Heading 1 — Pittsburgh Sites 

 

Doc-To-Help will use this structure to create topics, the table of contents, and automatic links. 

 

Close PittsburghQuickTour.doc and click the Build button in Doc-To-Help. The default NetHelp Target (chosen 

earlier) will be built.   

 

 
 

Doc-To-Help will prompt you to view the Target. Click Yes. 

 

 
 

(Your browser’s security settings may block display of NetHelp. Click “Allow blocked content” to view your Target.)  

 



 

Getting Started Workbook Doc-To-Help Quick Tour    19 

Take a look at the Target first (we built Responsive NetHelp, which adjusts for any device): 

 The Table of Contents structure is based on the Heading styles (since "Football", "Baseball", and "Hockey" 

were Heading 2s under the Heading 1 of "Pittsburgh Sports", they were converted to subtopics). 

 Click on the "Pittsburgh Sports" topic in the Table of Contents. The Topic has three automatic subtopic links — 

"Football", "Baseball", and "Hockey" — which were created by Doc-To-Help based on the document structure. 

We'll learn later how to add custom subtopics, but these are created automatically. 

 

 
 

Now a quick look at Doc-To-Help: 

 Click the Contents pane button. The Table of Contents is displayed. In this pane, you can rearrange the TOC 

any way you want, and add/delete topics, but the automatically generated Table of Contents is logical, and can 

be used as-is if you like. Note that the Table of Contents in the Contents pane looks exactly like the Table of 

Contents in the NetHelp Target. 

 Click the Topics window tab. Each Heading 1 and Heading 2 is a separate Topic in the project. This will make 

it possible to create links between topics and more.  

 

 
 

Now that we've seen our baseline, let's add more to this project. 
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Inserting a Graphic 
 

First, the graphic we need must be moved into our project. Using Windows Explorer, navigate to \\My Doc-To-Help 

Projects\Samples\All About Pittsburgh Word\Media. Copy Pittsburgh_Confluence.jpg. Drop it into the \\My Doc-To-

Help Projects\Pittsburgh\Media folder. (Although you can use images from any folder, it is a good best practice to store 

all of your images in your project's Media folder.) 

 

Just a reminder, the My Doc-To-Help Projects folder can be found here: 

 Windows® 7/8 and Vista:  \\Users\<username>\Documents\My Doc-To-Help Projects 

 Windows XP: \\Documents and Settings\<username>\My Documents\My Doc-To-Help Projects   

 

 
 

Now we are ready to insert our graphic. If it is not already open, double-click on PittsburghQuickTour.doc in the 

Documents pane to open it. 

 

Add a new line after the third paragraph (it begins with “The city of Pittsburgh…”). In the Insert ribbon, click the 

Picture button to open the Insert Picture dialog box. Choose Pittsburgh_Confluence.jpg and click the Insert drop-

down. Choose Insert and Link. This is the recommended option for Doc-To-Help projects. 
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The graphic is now inserted in the document. 
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By the way, you can quickly add a Flash movie to your project using the Flash Movie button on the Doc-To-Help 

ribbon tab. 
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Applying a Style 
 

Doc-To-Help uses styles to markup your source documents. In Word, these styles are in stored in a template (.dot or 

.dotx) file. The source styles are interpreted by the Target template to make the target files look and behave the way you 

desire. For example, as you saw earlier, Heading 1 and Heading 2 styles will determine your project's topic list, the 

structure of your Table of Contents and the automatic subtopic links. 

 

In this section, you will learn how to apply a Doc-To-Help style in Word. Although the style we will apply in this 

exercise is one that only controls formatting, later we will apply styles that control both formatting and behavior (see 

Adding Glossary Entries on page 39). 

 

If you were using Doc-To-Help's Content editor, you would apply styles using the Style List window, which is also very 

easy to use. 

 

When using Microsoft Word as your editor, you can apply styles quickly using the Home and Doc-To-Help ribbons.  
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Let's add some new text to PittsburghQuickTour.doc. After “Pittsburgh has over 80 different neighborhoods,” add: 

 

South Side (home of a mix of restaurants and live music venues) 

 

Station Square (home of the Gateway Clipper) 

 

Select the text and click the Styles dialog box launcher on the Home ribbon tab. The Styles box will open. (In Word 

2003, from the Format menu, choose Styles and Formatting. The Styles and Formatting box will open.) 

 

Choose the C1H Bullet style. The style is applied. 
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Open the Doc-To-Help ribbon tab, you’ll see that it includes the Heading 1, 2, 3, 4 and Body Text buttons so you can 

apply those styles quickly. 

 

 

Creating a Topic Link 
 

In PittsburghQuickTour.doc, go to the “North Shore” bullet and select the phrase "Pittsburgh Pirates" in the text, then 

click the Link button on the Doc-To-Help ribbon. The Link dialog box will open. 
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Take a quick look at the Link dialog box. Note that you can also create links to Keywords (AKA index entries), 

Groups, Bookmarks, Link tags, and Glossary entries. Simply click on the Link type drop-down. Also note that in the 

Options area, you can select the Show as Button check box. This will change your link text to a button. Selecting the 

Popup check box in the Link options will make the topic display in a popup window. By the way, linking will work in 

the PDF version of your manual target, as well as your Help targets. 

Handy Hint: You can select a Grid or Tree view of the "link to" topics. Click the button to the right to choose. 

 
 

Now that you have learned more about the Link dialog box — in the Topics tab, expand PittsburghQuickTour.doc (if 

necessary) and choose Baseball from the list. When you click OK, you will create a topic link from the phrase 

"Pittsburgh Pirates" to the topic about baseball. 

 

If you have hidden text turned “on” in your document, you will see the information for this link tag displayed. As you 

can see, the “tag” is the Topic you selected (“baseball”).  

 

 
 

If you would like to hide hidden text — in Word 2007/2010/2013, choose the Office button (or File tab) > Word 

Options, and click Display on the left. Clear the Hidden Text check box on the right. In Word 2003 and earlier, choose 

Tools > Options. In the View tab, Formatting Marks section, clear the Hidden Text check box and click OK.  
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Creating Inline Text 
 

Inline text is expanding, drop-down, or popup text. It's a great way to add dynamic information to your Help project.  

 

In PittsburghQuickTour.doc, select the phrase "250th Anniversary" from the first sentence and click the Inline Text 

button. Choose the Expand text inline radio button, and add text (Its semiquincentennial!) in the text box. 

 

 
 

Click OK. Doc-To-Help will inform you that this is an invisible style (this means the inline text we added will be 

invisible in this document [our Source document] — as well as in our Target until clicked). Since that is OK, click No to 

close the message box. When we build the Target, "250th Anniversary" will be a hyperlink that will display "Its 

semiquincentennial!" when clicked. Save and close the document, build, and take a look if you would like. 



 

28    Doc-To-Help Quick Tour Getting Started Workbook 

Creating an Index Entry 
 

You can add index keywords (also known as K-Links) right from your document. You can also do this in Doc-To-Help, 

which will be demonstrated later. 

 

Select the word "Monongahela" in PittsburghQuickTour.doc (it's in the 3
rd

 paragraph) and click the Keyword button 

on the Doc-To-Help ribbon. Click OK to add “Monongahela” to your index.  

 

“Monongahela” will display in your source document with a different text color, but that color change will not be visible 

in your final Targets. It is there in your source so that you can see it.  
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After you do a build, when you look in the Index and Groups pane of Doc-To-Help, Monongahela will be there. 

 

 
 

You can add additional keyword and secondary keywords from this dialog box. See Adding Items to the Index and 

Creating Groups on page 42. 

 

Let's build our target now and take a look at it. First, save and close PittsburghQuickTour.doc. Click the Build Target 

button  in Doc-To-Help. After the build is complete, view the Target. See Building and Examining a Target on page 

18 for more information. 

 

The project will open in your browser.  
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Click on "Pittsburgh's 250th Anniversary" in the table of contents. You'll see that: 

 "250th Anniversary" is a hyperlink that will display text (Its semiquincentennial!) when clicked. 

 "Monongahela" is not highlighted in the Target (but it is included in the Index — click the Index button above 

the Table of Contents). 

 The first two bullet points (about the South Side and Station Square) are properly formatted. 

 "Pittsburgh Pirates" is a hyperlink that opens the "Baseball" topic. 

 

You will also notice that the project name appears in the header as "Pittsburgh" — the name we gave the .D2H project 

in the wizard. We will change that in the next step using the Help Targets dialog box. 

Defining Help Targets 
 

By default, our sample has nine default Help Targets. Using the Help Targets dialog box in Doc-To-Help, we can 

rename our targets and delete the ones we don't need. 

 

First, click the Target ribbon group dialog box launcher to open the Help Targets dialog box. 

 

 
 

Since NetHelp is our default Target, that is the option displayed first. Let's change the Name field from "NetHelp" to 

"All About Pittsburgh NetHelp." 

 

As soon as you click in the window on the left, the name of the project will change in that list. 

Also enter "All About Pittsburgh" in the Caption field. This will change the name displayed in the browser from 

"Pittsburgh" to the name we prefer. 
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Click on the HTML Help (compiled HTML Help) Target on the left. Rename it also.  

 

Do the same with the Manual Target. While you are there, scroll down and change the "Title" to "All About 

Pittsburgh,” the "SuperTitle" to "Visitors Guide,” and the "By Line" to "Pittsburgh Productions."  

 

Since we don't need to create Help 2.0, JavaHelp, MS Help Viewer, Eclipse Help, or WinHelp for this project, click on 

those Targets in the window on the left and click the Remove Target button for each. (You can always add them back 

later.) Click OK. 

 

Now, click the Select Target button. The newly named Targets are displayed, instead of the defaults. 

 

 
 

If you'd like, save and close your documents. Select each Target, then build and view the Targets. You will see the 

changes we made displayed in each Target. 

 

Please note: you can have several versions of the same Target. For example, you could have multiple NetHelp Targets 

directed at different audiences. Just add them using the Add New Target button in the Help Targets dialog box. 
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Creating Custom Topic Relations 
 

As we discussed earlier, when you open your NetHelp Target and click on the "Pittsburgh Sports" topic in the Table of 

Contents, you will notice that at the bottom of the topic, there is a section that begins with "More:," followed by links to 

"Football," "Baseball," and "Hockey." These are called Subtopic Links and they are created automatically by Doc-To-

Help, based on the structure of your document.  

 

 
 

"Pittsburgh Sports" is a Heading 1, and "Football," "Baseball," and "Hockey" are Heading 2's immediately following it 

in PittsburghQuickTour.doc. If there were Heading 3's under "Football" they would appear as Subtopic Links in that 

topic.  

 

By default, the word "More" appears before the Subtopic links, but you can change that. Open the Help Targets dialog 

box for your Help Target and change it in the Label field. 

 

You can change it for individual topics by selecting a Topic in the Topics window and changing the Related Links 

Label in the Topics ribbon.  

 

 
 

It is easy to add your own custom topic relations using the Related Topics pane.  

 

Open the Related Topics pane and choose Pittsburgh Sports from the list. You'll see that "Football" "Baseball" and 

"Hockey" are displayed in the pane below automatically. Select Pittsburgh Sites from the Topics window and drag it 

into the lower Related Topics pane. It is now related (it is marked as a Custom related topic).  
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Save and close your documents, then click the Rebuild Target button and build your project. 
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Look at the new list of subtopic links for Pittsburgh Sports. “Pittsburgh Sites” has been added to the list.  

 

 
 

If you would prefer the subtopic links are not displayed in a specific topic, choose that topic in the Topics window and 

select the Hide Subtopic Links check box from the Topics tab. 

 

 
 

As you can see, automatic and custom topic relations give you a lot of options for navigating your Help project. 

 

For example: 

 You can create custom links to other topics that users may find useful — and the links are very clear and 

noticeable. 

 You can create custom links from subtopics to their "parent" topics — this directs the user back to the parent, 

which may lead them to other topics of interest. 

 Relating topics eliminates information "deadends" — the user has links to other information and could be saved 

the trouble of using search, or checking the TOC or index. 
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Adding a Document 
 

On occasion, you might need to add an existing document to your project after you've created it, so let’s do that now.  

 

We'll take this opportunity to add a Glossary to our project. 

 

Click the Add Existing Documents button in the Documents pane. 

 

 
 

The Document Import Wizard will open. Follow the same steps we used when importing PittsburghQuickTour.doc, 

but this time, choose Glossary.doc from the \\My Doc-To-Help Projects\Samples\All About Pittsburgh 

Word\Documents folder.  

 

We could have imported this originally, but now you can see how easy it is to do after you have already created your 

project … 
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After the import is complete, the new document will appear in the Documents pane. 

 

 
 

Since a Glossary is a special type of document in Doc-To-Help, right-click on it and choose Glossary from the menu. 
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Our document is now flagged as a Glossary with a special icon. 

 

 
 

Double-click on Glossary.doc to open it.  You'll see that two index entries are in this document: Confluence and 

Primanti Brothers Sandwich. If you put your cursor in either heading, you'll notice that they are formatted with the 

Glossary Heading style. This style has a special behavior in online Help Targets. 

 

Close Glossary.doc and build your Target. You'll notice that Glossary has been added to the Table of Contents, plus the 

word "confluence" is now a hyperlink. When you click on it, the glossary entry is displayed as a popup.  
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This popup is a Doc-To-Help feature — Doc-To-Help automatically creates links from topic text to identical glossary 

entries – but only once in each topic. This can be turned off if you like, but it is a great way to give your readers access to 

useful definitions that they might normally miss, with no extra work on your part. If you would like to create a manual 

link to a glossary entry, simply create a link using the Glossary Link Type in the Link dialog box. 

Note: To add a new, empty document to your project, click the Add New Document button in the Documents pane 

toolbar. 
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Adding Glossary Entries 
 

It is easy to add additional entries to your glossary — and you don't need to worry about alphabetizing them because 

Doc-To-Help will do it for you. 

 

Open Glossary.doc. It contains two entries. 

 

 
 

It's easy to add more entries and alphabetize the list. 

 

After the first two entries, add the following: 

 

Ohio River 

A river that begins in Pittsburgh and joins the mighty Mississippi in Illinois. 

 

Now, we need to apply styles to the new entry. These styles not only control the look of the entries, but also the 

behavior. 

 

Click on Confluence, you'll notice the style is Glossary Heading. The definition is C1H Popup Topic Text. Apply 

those styles to Ohio River and its definition. (Use the same method we used when we applied the C1H Bullet style 

earlier.) 
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It will look like this: 

 

 
 

Ohio River is in the Glossary, but now the Glossary is not in alphabetical order. To fix that, click the Sort button in the 

Doc-To-Help ribbon. The Glossary will now be alphabetized. 

 

 
 

Save and close Glossary.doc. Build the project. 

 

"Ohio River" is now in the list of topics in the Topics window. 

 



 

Getting Started Workbook Doc-To-Help Quick Tour    41 

 

Creating a Customized Table of Contents 
 

As you've already seen, Doc-To-Help automatically creates a Table of Contents for you based on the structure of your 

documents. But you can customize your Table of Contents if you wish. 

 

Open the Contents pane. If you select an item in the Table of Contents and click Remove Topic to remove it — or drag 

a topic from the Topics window into the Contents pane to add it — the table of contents will be flagged as 

Customized. Changing the name of an item in the TOC (using the Rename button) will also customize it. 

 

 
 

If you would like this table of contents to be exclusively used for the Target selected, click the Target-Specific Table of 

Contents button. 

 

 
 

If you decide that you would prefer to return to the original table of contents (based on the document structure) click the 

Rebuild Table of Contents button. 
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Adding Items to the Index and Creating Groups 
 

There is already one item in our index, which we added directly from one of our documents. We can also add items using 

the Index and Groups pane, along with the Topics window. 

 

Click on the Index and Groups pane, and click the Keyword button. 

 

 
 

Click the Add New Keyword button.  
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Name the keyword "sightseeing." Then select the topic "Pittsburgh Sites" from the Topics window and drag it into the 

lower Keywords pane. You can link multiple topics to a single keyword; just drag them into the lower pane also. 

 

 
 

You can create topic Groups using this same pane. Topic groups are collections of topics you can create links to. When 

the user clicks the link, the topics in the group will display in a popup window or dialog box.  

 

First, click the Groups button in the Index and Groups pane. 
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Click the Add Group button and name the new group "Sports." 

 

 
 

Select the topics "Football", "Baseball", and "Hockey" in the Topics window and drag them into the lower Groups 

pane. 

 

 
 

These topics are now a group named "Sports" and you can create a link to them using the Link dialog box.  

 

Open PittsburghQuickTour.doc and in the "Pittsburgh Sports" topic, select the word "sports."  

 

Click the Link button on the Doc-To-Help ribbon tab and choose Group from the Link type drop-down. Select the 

Sports check box and click OK.  
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Save and close your document. Build your Target. 
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Now, "sports" is a hyperlink, and when you click on it, a menu with all of the topics in that group displays. Select any 

one of the menu items, and the topic opens. 

 

 
 

We hope you enjoyed the Doc-To-Help Quick Tour! Feel free to use this project to test-drive Doc-To-Help further.  

Additional Resources 
The schedule of free Doc-To-Help introductory webcasts can be found at: 

http://www.doctohelp.com/SuperPages/Webcasts/.  

 

Information about training classes and self-paced training manuals is available here: 

http://www.doctohelp.com/SuperProducts/DocumentationSupport/Training+/. 

 

Sample Doc-To-Help projects can be found in the following location. These projects demonstrate Doc-To-Help features 

and functionality. There are sample projects that feature each type of document editor, software documentation, API 

reference documentation, an employee policy manual, and more. 

 Windows® 7/8 and Vista:  \\Users\<username>\Documents\My Doc-To-Help Projects\Samples 

 Windows XP: \\Documents and Settings\<username>\My Documents\My Doc-To-Help Projects\Samples 

 

Also see the PDF quick reference guides available on the Start Page of Doc-To-Help, and the Help menu (available 

from the File tab.) 

http://www.doctohelp.com/SuperPages/Webcasts/
http://www.doctohelp.com/SuperProducts/DocumentationSupport/Training+/
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